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IFMBE Proceedings Series– Instructions for Authors  
A.B. Firstauthor1, C. Coauthor2 and D.E. Othercoauthor1 

1 Institution/Department, Affiliation, City, Country  
2 Institution/Department, Affiliation, City, Country 

Abstract— Instructions for preparing papers for IFMBE 
Proceedings Series are presented. They are intended to guide 
the authors in preparing the electronic version of their paper. 
Only papers prepared according to these instructions will be 
published in the paper and online version of Proceedings. 
Provide an abstract of your paper no longer than 300 words. 

Keywords— Enter up to five keywords and separate them 
by commas. 

I. INTRODUCTION  

These are the instructions for preparing papers for the 
IFMBE Proceedings Series. English is the official language. 
Please, do not forget to prove the spelling with your spell 
checker. Set the language to English (U.S.). Read the in-
structions in this sample paper carefully before typing. 

The papers should be submitted in their final form. The 
publisher will perform no further adjustments. In the Pro-
ceedings the papers will be reproduced directly from the 
files submitted by the authors. The authors must upload 
their paper in MS Word and Pdf format through the confe-
rence management system. 

Detailed instructions for preparing the papers are listed in 
chapter II. WRITING THE PAPER. When you write the paper, 
you can either follow the descriptive rules presented in 
subchapter A. Descriptive rules, or install the macros pre-
pared by the publisher, as described in subchapter B. Using 
macros. 

II. WRITING THE PAPER 

A. Descriptive rules 

Paper Size: Select the custom size of paper, i.e. 21 x 27.9 
cm in Page Setup in your Word Processor. Only this paper 
size can be accepted. 

Length: The maximum document size for regular and 
Young Investigator Competition papers is four pages. Ab-
stracts only will not be published.  

Margins: The page layout should be "mirror margins". 
Leave 2.5 cm margin at the top, 4 cm at the bottom, 1.9 cm 
on the inside and 1.4 cm at the outside side of the page. 

Page Layout: Type the paper in two columns 85,5 mm 
wide with a space of 6 mm between the columns. Each 
column should be left and right justified. 

Fonts: Use Roman typeface (e.g. Times, Times New 
Roman) and single line spacing throughout the paper.  

Title: The title should be no longer than two lines. Avoid 
unusual abbreviations. Center the title (14 point bold). 
Authors’ names and affiliations (Institution/Department, 
City, Country) shall span the entire page. Leave one blank 
line (8 point) after the title, one blank line (10 point) after 
the authors’ names and affiliations. Leave one blank line 
(20 point) between author’s info and the beginning of the 
paper. 

Abstract: Provide an abstract of the paper (9 point bold) 
no longer than 300 words.  

Style: Use separate sections for introduction, materials 
and methods, results, discussion, conclusions, acknowledg-
ments (when appropriate), and references.  

Headings: Enumerate Chapter Headings by Roman 
numbers (I., II., etc.). For Chapter Headings use ALL CAPS. 
First letter of Chapter Heading is font size 12, regular and 
other letters are font 8 regular style. Leave one blank line 
(20 point) before and one blank line (10 point) after each 
Chapter Heading. Subchapter Headings are font 10, italic. 
Enumerate Subchapter Headings by capital letters (A., B., 
etc.). Leave one blank line (15 point) before and one blank 
line (7,5 point) after each Subchapter Heading. 

Body Text: Use Roman typeface (10 point regular) 
throughout. Only if you want to emphasize special parts of 
the text use Italics. Start a new paragraph by indenting it 
from the left margin by 4 mm (and not by inserting a blank 
line). Font sizes and styles to be used in the paper are sum-
marized in Table 1. 

Tables: Insert tables where appropriate (as close as poss-
ible to where they are mentioned in the text). Prefer posi-
tioning them at the top or at the bottom of the column. If 
necessary, span them over both columns. Enumerate them 
consecutively using Arabic numbers and provide a caption 
for each table (e.g. Table 1, Table 2,..). Use font 10 regular 
for Table caption, 1st letter, and font 8 regular for the rest of 
table caption and table legend. Place table captions and 
table legend above the table. Leave one blank line before 
(15 point) and one after (5 point) the captions. Please keep 
in mind the distinction between tables and figures: tables 
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only contain alphanumerical characters and no graphical 
elements.  

Table 1 Font sizes and styles 

Item Font Size Font Style 
Title 14 Bold 
Author 12 Regular 
Authors’ info 9 Regular 
Abstract 9 Bold 
Keywords 9 Bold 
Body text 10 Regular 
Chapter heading, 1st letter 12 Regular 
Chapter heading, other letters 8 Regular 
Subchapter heading  10 Italic 
Table caption, 1st letter 10 Regular 
Table legend 8 Regular 
Column titles 8 Regular 
Table data 8 Regular 
Figure caption, 1st letter 10 Regular 
Figure legend 8 Regular 
Acknowledgment  8 Regular 
References 8 Regular 
Author’s address 8 Regular 

 
Figures: Insert figures where appropriate (as close as 

possible to where they are mentioned in the text). Prefer 
positioning them at the top or at the bottom of the column. 
If necessary, span them over both columns. Enumerate them 
consecutively using Arabic numbers and provide a caption 
for each figure (e.g. Fig. 1, Fig. 2,..). Use font 10 regular for 
Figure caption, 1st letter, and font 8 regular for the rest of 
figure caption and figure legend. Place figure legend be-
neath figures. Leave one blank line before (5 point) and one 
after (15 point) the captions. Please keep in mind the dis-
tinction between tables and figures: tables only contain 
alphanumerical characters and no graphical elements. Do 
not use characters smaller than 8 points within figures. Fig-
ures are going to be reproduced in color in the electronic 
versions of the Proceedings, but when choosing graph col-
ors, keep in mind that they might be printed in black and 
white color. Figure 1 is intended to illustrate the positioning 
of a figure and shows the logo of the IFMBE. 

Equations: For inserting equations, use the Equation Edi-
tor. Enumerate the equations using Arabic numbers in 
brackets on the right hand side of the equation. 

Itemizing: In case you need to itemize parts of your text, 
use either bullets or numbers, as shown bellow: 

• First item 
• Second item 

1. Numbered first item 
2. Numbered second item 

References: Use Arabic numbers in square brackets to 
number references in such order as they appear in the text . 
List them in numerical order as presented under the heading 
‘REFERENCES’ at the end of this Instructions. 

B. Using macros 

a) Word2003: 
Macro security: Change in MS Word the basic setting 

“macro security” as described: 

Menu bar: “Tools → Macro → Security  
→ Middle or Medium“ 

b) Word2007: 
Macro security: Change in MS Word the basic setting 

“macro security” as described: 

Menu bar: “Trust Center → Macro Settings → Security  
→ Warnings for all macros “ 

Activating the “Developer tab” in order to display the 
macro buttons. 

Click the Microsoft Office Button      and then click 
“Word Options”. Click “Popular”, and then select the 
“Show Developer tab” in the Ribbon check box.  

Now the macro buttons can be found at “Add-Ins” in the 
menu. 

c) Word2003 and Word2007: 
Restart MS Word again. A message will appear on the 

screen stating that the file you are using contains Macros. 
Click at “Enable Macros”. 

File deposition: Copy the file IFMBE_Proceedings_ 
Template_2.dot into the same folder in which your  
word-templates are usually located (e.g. the template  
“normal.dot”). 

Writing the article: When you start working with the 
template you have (amongst others) the following two op-
tions:  

• Highlight the file IFMBE Proceedings_Template_2.dot 
in the Explorer and choose in the menu “File → New”. 

• Open a new or an existing word-document and select in 
menu Tools the item “Templates and Add-Ins”. Click  
in the Window on “Connect”, choose IFMBE_ 
Proceedings_Template_2.dot, set a check on “Update 
Templates Automatically” and click OK. 

Page setup: The page setup in this template is set to cus-
tom size of paper, i.e. 21 x 27.9 cm. The margins should be 
preset to “mirror margins”. In case the margins are not pre-
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set as “mirror margins”, use the macro [margins] and 
choose the option [mirror margins] on the menu bar. 

Document structure: The first part contains a column 
with the paper title, the author(s) names, initials and au-
thors’ affiliation information. The title should be no longer 
than two lines. Avoid unusual abbreviations. Authors’ 
names and affiliations (Institution/Department, City, Coun-
try) shall span the entire page. The second part includes two 
columns and starts with Abstract and Keywords. For for-
matting any of these items, you may use macros from the 
menu bar [article head]. Click on the [article head] button 
and choose the appropriate format from the falling menu. 

Heading styles: Templates for paragraphs are defined 
with attributes of paragraphs (justification, distances in front 
and after a paragraph etc.) and font. If you use the Heading1 
[H1] macro from the menu bar for formatting the headings 
of the paragraphs - the first letter will be written in capital 
letters and formatted two points larger than the other letters 
in the heading. Please write the text and then click button 
[H1] on the menu bar once again. If second level heading - 
Heading2 [H2] immediately follows Heading1 use macro 
[heading2_heading1] from the menu bar to format the head-
ing. This macro prevents double distances between Head-
ing1 and Heading2. 

Macros for characters: With macros [characters tem-
plate] you can format individual characters or words within 
a paragraph in font style: bold, italic, symbol, initial etc. 

Table 2  Table caption 

Table legend   

Table data   
 
Importing Tables: This template enables you to format 

tables within one column. In order to insert a table please 
use the macro [table] from the menu bar and click on [create 
table complete].  

You will be asked for the number of rows and columns in 
your table. Please enter the number of rows and columns 
into the Input box. The table will be inserted in the docu-
ment and completely formatted. 

The first letters in the caption of Table and Figure will be 
formatted two points larger as described for Heading1. You 
have to use the macro [initial_10] from the menu offered by 
clicking on the button [characters template] menu. 

To align the table to the column width, click the button  
[table] on the menu bar, and then choose [table column 
width] from the offered menu. 

Importing figures: In order to insert a figure, click the 
button [figure] on the menu bar, and then choose [insert 
figure complete] from the offered menu. Select in the win-
dow the figure you want to import and click on “insert”. 

The figure caption is formatted with the macros and the 
[figlegend] and [counter figure] from the menu bar. 

Equation: Write the equation in equation editor. Equa-
tions are formatted with the macro [equation].  

 A + B = C (1) 

In order to insert the equation number click the button 
[equation] on the menu bar and then choose [counter equa-
tion] from the offered menu. Separate the equation and the 
equation number by using the right tab on the keyboard. In 
order to achieve the requested spacing between the para-
graphs and the equation click the button [equation] on the 
menu bar and then choose [template equation] . 

 xtX A 21kte= × +  (2) 

 

Fig. 1 IFMBE logo 

Enumeration: There are two different kinds of formatting 
for enumerations. In order to use bullets, click the button 
[item] on the menu bar, and then choose [itemize]. In order 
to use numbering select the text, click the button [item] on 
the menu bar, and then choose [enumerate] in order to start 
the numbering with number 1 or choose [enumerate (cont)] 
in order to continue the numbering.  

• itemize 
• Macro: [item–itemize] 

1. enumerate 
2. Macro: [item–enumerate] 
To continue numbering: 
3. Macro: [item–enumerate (cont)]. 

Acknowledgment: For formatting the headlines without 
numbering (e.g. Acknowledgment and References) use the 
style “HEADING1_WITHOUTNR“ from the style drop 
menu. 

References: For automatically numbering of your refer-
ences use the style: [reference_Item] from the menu bar. 
The Internet addresses should be formatted with [refer-
ence_available]. 
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III. CONCLUSIONS  

Send your papers only in electronic form. Papers must be 
uploaded before the deadline. After a paper is accepted for 
oral or poster presentation, one of the authors must com-
plete a registration form and pay the appropriate fees before 
the paper can be published in the Proceedings. Please pay 
attention to the registration deadline. 

To view the prescribed text boundaries of the paper use 
macro [view] on the menu bar and then choose [recom-
mended view]. In order to reset this option choose option 
[undo recommended] from the menu bar [view]. 

ACKNOWLEDGMENT 

Format the Acknowledgment and References headlines 
without numbering. 

REFERENCES  

The list of References should only include papers that are 
cited in the text and that have been published or accepted 
for publication. Citations in the text should be identified by 
numbers in square brackets and the list of references at the 
end of the paper should be numbered according to the order 
of appearance in the text. Examples of citations for Journal 
articles [1], books [2], the Digital Object Identifier (DOI) of 

the cited literature (which should be added at the end of the 
reference in question if available) [3], Proceedings papers 
[4] and electronic publications [5]. 

Cited papers that have been accepted for publication 
should be included in the list of references with the name of 
the journal and marked as ‘‘in press’’. The author is respon-
sible for the accuracy of the references. Journal titles should 
be abbreviated according to Engineering Index Inc. Refer-
ences with correct punctuation.  

 
1. Smith J, Jones M Jr, Houghton L et al. (1999) Future of health insur-

ance. N Engl J Med 965:325–329 
2. South J, Blass B (2001) The future of modern genomics. Blackwell, 

London 
3. Smith J, Jones M Jr, Houghton L et al (1999) Future of health insur-

ance. N Engl J Med 965:325–329 DOI 10.10007/s002149800025 
4. Lock I, Jerov M, Scovith S (2003) Future of modeling and simulation, 

IFMBE Proc. vol. 4, World Congress on Med. Phys. & Biomed. Eng., 
Sydney, Australia, 2003, pp 789–792 

5. IFMBE at http://www.ifmbe.org 

Use macro [author address] to enter  the address of the corresponding 
author: 

Author:  
Institute:  
Street:  
City:  
Country:  
Email:  
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